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Abstract 
The Deployment Guide documents relevant information regarding the deployment, 
configuration, and administration of Fedora 15. It is oriented towards system administrators 
with a basic understanding of the system. 
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Preface 
The Deployment Guide contains information on how to customize the Fedora 15 system to fit 
your needs. If you are looking for a comprehensive, task-oriented guide for configuring and 
customizing your system, this is the manual for you.  

This manual discusses many intermediate topics such as the following:  

• Installing and managing packages using the graphical PackageKit and command 
line Yum package managers  

• Setting up a network—from establishing an Ethernet connection using 
NetworkManager to configuring channel bonding interfaces to increase server 
bandwidth  

• Configuring DHCP, BIND, Apache HTTP Server, Postfix, Sendmail and other 
enterprise-class servers and software  

• Gathering information about your system, including obtaining user-space crash data 
with the Automatic Bug Reporting Tool, and kernel-space crash data with kdump  

• Easily working with kernel modules and upgrading the kernel  

1. Target Audience 

The Deployment Guide assumes you have a basic understanding of the Fedora operating 
system. If you need help with the installation of this system, refer to the Fedora 15 Installation 
Guide.  

2. How to Read this Book 

This manual is divided into the following main categories:  

Part I, Basic System Configuration (page 35) 

This part covers basic system administration tasks such as keyboard configuration, date 
and time configuration, and managing users and groups.  
Chapter 1, Language and Keyboard Configuration (page 36) covers basic language and 
keyboard setup. Read this chapter if you need to configure the language of your 
desktop, change the keyboard layout, or add the keyboard layout indicator to the panel.  
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Chapter 2, Date and Time Configuration (page 39) covers the configuration of the system 
date and time. Read this chapter if you need to change the date and time setup, or 
configure the system to synchronize the clock with a remote Network Time Protocol 
(NTP) server.  
Chapter 3, Managing Users and Groups (page 44) covers the management of users and 
groups in a graphical user interface and on the command line. Read this chapter if you 
need to manage users and groups on your system, or enable password aging.  

Part II, Package Management (page 69) 
This part describes how to manage software packages on Fedora using both Yum and 
the PackageKit suite of graphical package management tools.  
Chapter 4, Yum (page 70) describes the Yum package manager. Read this chapter for 
information how to search, install, update, and uninstall packages on the command line.  
Chapter 5, PackageKit (page 91) describes the PackageKit suite of graphical package 
management tools. Read this chapter for information how to search, install, update, and 
uninstall packages using a graphical user interface.  

Part III, Networking (page 103) 
This part describes how to configure the network on Fedora.  
Chapter 6, Network Interfaces (page 104) explores various interface configuration files, 
interface control scripts, and network function files located in the 
/etc/sysconfig/network-scripts/ directory. Read this chapter for information how 
to use these files to configure network interfaces.  

Part IV, Infrastructure Services (page 119) 
This part provides information how to configure services and daemons, configure 
authentication, and enable remote logins.  
Chapter 7, Services and Daemons (page 120) explains the concept of runlevels, and 
describes how to set the default one. It also covers the configuration of the services to be 
run in each of these runlevels, and provides information on how to start, stop, and 
restart a service. Read this chapter to learn how to manage services on your system.  
Chapter 8, Configuring Authentication (page 125) describes how to configure user 
information retrieval from Lightweight Directory Access Protocol (LDAP), Network 
Information Service (NIS), and Winbind user account databases, and provides an 
introduction to the System Security Services Daemon (SSSD). Read this chapter if you 
need to configure authentication on your system.  
Chapter 9, OpenSSH (page 168) describes how to enable a remote login via the SSH 
protocol. It covers the configuration of the sshd service, as well as a basic usage of the 
ssh, scp, sftp client utilities. Read this chapter if you need a remote access to a 
machine.  
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Part V, Servers (page 185) 

This part discusses various topics related to servers such as how to set up a Web server 
or share files and directories over the network.  
Chapter 10, DHCP Servers (page 186) guides you through the installation of a Dynamic 
Host Configuration Protocol (DHCP) server and client. Read this chapter if you need to 
configure DHCP on your system.  
Chapter 11, DNS Servers (page 198) introduces you to Domain Name System (DNS), 
explains how to install, configure, run, and administer the BIND DNS server. Read this 
chapter if you need to configure a DNS server on your system.  
Chapter 12, Web Servers (page 225) focuses on the Apache HTTP Server 2.2, a robust, 
full-featured open source web server developed by the Apache Software Foundation. 
Read this chapter if you need to configure a web server on your system.  
Chapter 13, Mail Servers (page 272) reviews modern email protocols in use today, and 
some of the programs designed to send and receive email, including Postfix, Sendmail, 
Fetchmail, and Procmail. Read this chapter if you need to configure a mail server on 
your system.  
Chapter 14, Directory Servers (page 302) covers the installation and configuration of 
OpenLDAP 2.4, an open source implementation of the LDAPv2 and LDAPv3 protocols. 
Read this chapter if you need to configure a directory server on your system.  
Chapter 15, File Servers (page 317) guides you through the installation and configuration 
of Samba, an open source implementation of the Server Message Block (SMB) protocol, 
and vsftpd, the primary FTP server shipped with Fedora. Read this chapter if you need 
to configure a file server on your system.  

Part VI, Monitoring and Automation (page 358) 

This part describes various tools that allow system administrators to monitor system 
performance, automate system tasks, and report bugs.  
Chapter 16, System Monitoring Tools (page 359) discusses applications and commands 
that can be used to retrieve important information about the system. Read this chapter to 
learn how to gather essential system information.  
Chapter 17, Viewing and Managing Log Files (page 366) describes the configuration of the 
rsyslog daemon, and explains how to locate, view, and monitor log files. Read this 
chapter to learn how to work with log files.  
Chapter 18, Automating System Tasks(page 388) provides an overview of the cron, at, 
and batch utilities. Read this chapter to learn how to use these utilities to perform 
automated tasks.  
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Chapter 19, Automatic Bug-Reporting Tool (ABRT) (page 397) concentrates on ABRT, a 
system service and a set of tools to collect crash data and send a report to the relevant 
issue tracker. Read this chapter to learn how to use ABRT on your system.  

Part VII, Kernel, Module and Driver Configuration (page 412) 

This part covers various tools that assist administrators with kernel customization.  
Chapter 20, Manually Upgrading the Kernel (page 413) provides important information 
how to manually update a kernel package using the rpm command instead of yum. Read 
this chapter if you cannot update a kernel package with the Yum package manager.  
Chapter 21, Working with Kernel Modules (page 422) explains how to display, query, load, 
and unload kernel modules and their dependencies, and how to set module parameters. 
Additionally, it covers specific kernel module capabilities such as using multiple 
Ethernet cards and using channel bonding. Read this chapter if you need to work with 
kernel modules.  
Chapter 22, The kdump Crash Recovery Service (page 439) explains how to configure, test, 
and use the kdump service in Fedora, and provides a brief overview of how to analyze 
the resulting core dump using the crash debugging utility. Read this chapter to learn 
how to enable kdump on your system.  

Appendix A, RPM (page 456) 

This appendix concentrates on the RPM Package Manager (RPM), an open packaging 
system used by Fedora, and the use of the rpm utility. Read this appendix if you need to 
use rpm instead of yum.  

Appendix B, The sysconfig Directory (page 470) 

This appendix outlines some of the files and directories located in the /etc/sysconfig/ 
directory. Read this appendix if you want to learn more about these files and directories, 
their function, and their contents.  

Appendix C, The proc File System (page 488) 

This appendix explains the concept of a virtual file system, and describes some of the 
top-level files and directories within the proc file system (that is, the /proc/ directory). 
Read this appendix if you want to learn more about this file system.  

3. Document Conventions 

This manual uses several conventions to highlight certain words and phrases and draw 
attention to specific pieces of information. 
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In PDF and paper editions, this manual uses typefaces drawn from the Liberation Fonts1

3.1. Typographic Conventions 

 set. 
The Liberation Fonts set is also used in HTML editions if the set is installed on your system. 
If not, alternative but equivalent typefaces are displayed. Note: Red Hat Enterprise Linux 5 
and later includes the Liberation Fonts set by default. 

Four typographic conventions are used to call attention to specific words and phrases. These 
conventions, and the circumstances they apply to, are as follows. 
Mono-spaced Bold 

Used to highlight system input, including shell commands, file names and paths. Also used 
to highlight key caps and key-combinations. For example: 

To see the contents of the file my_next_bestselling_novel in your current working 
directory, enter the cat my_next_bestselling_novel command at the shell prompt 
and press Enter to execute the command. 

The above includes a file name, a shell command and a key cap, all presented in Mono-
spaced Bold and all distinguishable thanks to context. 

Key-combinations can be distinguished from key caps by the hyphen connecting each part 
of a key-combination. For example: 

Press Enter to execute the command. 
Press Ctrl+Alt+F2 to switch to the first virtual terminal. Press Ctrl+Alt+F1 to return to 
your X-Windows session. 

The first sentence highlights the particular key cap to press. The second highlights two sets 
of three key caps, each set pressed simultaneously. 

If source code is discussed, class names, methods, functions, variable names and returned 
values mentioned within a paragraph will be presented as above, in Mono-spaced Bold. 
For example: 

File-related classes include filesystem for file systems, file for files, and dir for 
directories. Each class has its own associated set of permissions. 

Proportional Bold 

This denotes words or phrases encountered on a system, including application names; 
dialogue box text; labelled buttons; check-box and radio button labels; menu titles and sub-
menu titles. For example: 

                                                      
1 https://fedorahosted.org/liberation-fonts/ 
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Choose System > Preferences > Mouse from the main menu bar to launch Mouse 
Preferences. In the Buttons tab, click the Left-handed mouse check box and click Close 
to switch the primary mouse button from the left to the right (making the mouse 
suitable for use in the left hand). 
To insert a special character into a gedit file, choose Applications > Accessories > 
Character Map from the main menu bar. Next, choose Search > Find… from the 
Character Map menu bar, type the name of the character in the Search field and click 
Next. The character you sought will be highlighted in the Character Table. Double-click 
this highlighted character to place it in the Text to copy field and then click the Copy 
button. Now switch back to your document and choose Edit > Paste from the gedit 
menu bar. 

The above text includes application names; system-wide menu names and items; 
application-specific menu names; and buttons and text found within a GUI interface, all 
presented in Proportional Bold and all distinguishable by context. 

Note the > shorthand used to indicate traversal through a menu and its sub-menus. This is 
to avoid the difficult-to-follow 'Select Mouse from the Preferences sub-menu in the System 
menu of the main menu bar' approach. 

Mono-spaced Bold Italic or Proportional Bold Italic 

Whether Mono-spaced Bold or Proportional Bold, the addition of Italics indicates 
replaceable or variable text. Italics denotes text you do not input literally or displayed text 
that changes depending on circumstance. For example: 

To connect to a remote machine using ssh, type ssh username@domain.name at a shell 
prompt. If the remote machine is example.com and your username on that machine is 
john, type ssh john@example.com. 

The mount -o remount file-system command remounts the named file system. For 
example, to remount the /home file system, the command is mount -o remount /home. 

To see the version of a currently installed package, use the rpm -q package command. 
It will return a result as follows: package-version-release. 

Note the words in bold italics above — username, domain.name, file-system, package, 
version and release. Each word is a placeholder, either for text you enter when issuing a 
command or for text displayed by the system. 

Aside from standard usage for presenting the title of a work, italics denotes the first use of a 
new and important term. For example: 

When the Apache HTTP Server accepts requests, it dispatches child processes or threads 
to handle them. This group of child processes or threads is known as a server-pool. Under 



Preface 

   
33 

Apache HTTP Server 2.0, the responsibility for creating and maintaining these server-
pools has been abstracted to a group of modules called Multi-Processing Modules 
(MPMs). Unlike other modules, only one module from the MPM group can be loaded by 
the Apache HTTP Server. 

3.2. Pull-quote Conventions 

Two, commonly multi-line, data types are set off visually from the surrounding text. 

Output sent to a terminal is set in Mono-spaced Roman and presented thus: 
books        Desktop   documentation  drafts  mss    photos   stuff  svn 
books_tests  Desktop1  downloads      images  notes  scripts  svgs 

Source-code listings are also set in Mono-spaced Roman but are presented and highlighted 
as follows: 
package org.jboss.book.jca.ex1; 
 
import javax.naming.InitialContext; 
 
public class ExClient 
{ 
   public static void main(String args[]) 
       throws Exception 
   { 
      InitialContext iniCtx = new InitialContext(); 
      Object         ref    = iniCtx.lookup("EchoBean"); 
      EchoHome       home   = (EchoHome) ref; 
      Echo           echo   = home.create(); 
 
      System.out.println("Created Echo"); 
 
      System.out.println("Echo.echo('Hello') = " + echo.echo("Hello")); 
   } 
 
} 

3.3. Notes and Warnings 

Finally, we use three visual styles to draw attention to information that might otherwise be 
overlooked. 

Note 

A note is a tip or shortcut or alternative approach to the task at hand. Ignoring a note 
should have no negative consequences, but you might miss out on a trick that makes 
your life easier. 
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Important 

Important boxes detail things that are easily missed: configuration changes that only 
apply to the current session, or services that need restarting before an update will 
apply. Ignoring Important boxes will not cause data loss but may cause irritation 
and frustration. 

Warning 

A Warning should not be ignored. Ignoring warnings will most likely cause data 
loss. 

4. Feedback 

If you find a typographical error in this manual, or if you have thought of a way to make 
this manual better, we would love to hear from you! Please submit a report in Bugzilla2

When submitting a bug report, be sure to provide the following information:  

 
against the product Fedora Documentation.  

• Manual's identifier: deployment-guide  
• Version number: 15  

If you have a suggestion for improving the documentation, try to be as specific as possible 
when describing it. If you have found an error, please include the section number and some 
of the surrounding text so we can find it easily.  
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2 http://bugzilla.redhat.com/ 
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Part I.  
Basic System Configuration 

This part covers basic system administration tasks such as keyboard configuration, date and 
time configuration, and managing users and groups. 
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Chapter 1. 
Language and Keyboard Configuration 

This chapter describes how to change the language of your desktop, configure the keyboard 
layout, and allow a user to switch between different keyboard layouts using the Region and 
Language configuration tool.  

1.1. Changing the Language 

To configure the language of your desktop, open the System Settings dialog window by 
selecting Applications → System Tools → System Settings from the Activities menu, click 
Region and Language, and select the Language tab. You will be presented with a list of 
available languages. 

 
Figure 1.1. Changing the language 
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To choose a particular language, select it from the list and either close the window, or click 
the All Settings button in the upper-left corner of the window to return to the System 
Settings window. The changes will take effect the next time you log in to your system.  

1.2. Changing the Keyboard Layout 

Although the installation program allows a system administrator to configure a keyboard 
layout during the system installation, the default settings may not always suit your current 
needs. To add a new keyboard layout, open the System Settings window by selecting 
Applications → System Tools → System Settings from the Activities menu, click the 
Region and Language icon, and select the Layouts tab.  

 
Figure 1.2. Changing the keyboard layout 

The left part of the window provides a list of currently enabled layouts, while the right part 
allows you to choose whether to use the same keyboard layout for all windows, or if you 
prefer to use a different layout for each window.  
To add a keyboard layout, click the + (that is, the plus sign) button below the list. A dialog 
box will appear, allowing you to select the desired layout. The input field in the bottom part 
of the dialog box allows you to reduce the number of displayed items by typing part of the 
layout name (such as “slov” for Slovak layouts) in it. Once you are done, click the Add 
button to confirm your choice.  
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Figure 1.3. Adding a keyboard layout 

To remove a keyboard layout, click the − (that is, the minus sign) button below the list.  

When more than one layout is enabled, a keyboard indicator appears on the panel in order 
to allow you to switch between the layouts, and the first layout in the list is considered the 
default. To move a particular layout up or down in the list, select it from the list and click 
the ↑ (the upwards arrow) or ↓ (the downwards arrow) buttons respectively.  

 
Figure 1.4. The keyboard layout indicator 

The changes take effect immediately. 
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Chapter 2. 
Date and Time Configuration 

This chapter covers setting the system date and time in Fedora, both manually and using the 
Network Time Protocol (NTP), as well as setting the adequate time zone. Two methods are 
covered: setting the date and time using the Date and Time configuration tool, and doing so 
on the command line.  

2.1. Date and Time Configuration Tool 

The Date and Time configuration tool allows a user to change the system date and time, to 
configure the time zone used by the system, and to set up the Network Time Protocol 
daemon to synchronize the system clock with a time server.  

To start the tool, select Applications → System Tools → System Settings from the 
Activities menu and click the Date and Time icon, or click the time in the panel and select 
Date and Time Settings from the drop-down menu.  

 
Figure 2.1. Running the Date and Time configuration tool 
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By default, the tool only allows you to review the current settings. This is because only root 
is allowed to set the system date and time. To unlock the configuration tool for changes, 
click the Unlock button in the bottom-left corner of the window, and provide the root 
password when prompted.  

 
Figure 2.2. The Date and Time configuration tool 

As you can see in Figure 2.2. The Date and Time configuration tool above, the main window of 
the Date and Time configuration tool is divided into two parts: while the left side of the 
window is dedicated to the time zone settings, the right part allows you to configure the 
date and time itself.  

To change the time zone, click on the map, or select the region and city from the Region and 
City drop-down lists.  

To change the current time of your system, either configure the system to synchronize it 
over the network by clicking the Network Time switch, or set it manually by clicking the up 
and down arrows above and below the numbers. Use the 24-Hour Time switch to enable or 
disable the 24-hour time format.  

To change the current date of your system, select a month from the drop-down list below 
the time, and use the up and down arrows to choose the day and year.  

The changes take effect immediately.  
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2.2. Command Line Configuration 

In case your system does not have the Date/Time Properties tool installed, or the X Window 
Server is not running, you can change the system date and time on the command line. Note 
that in order to perform actions described in this section, you have to be logged in as root. 
To do so, type the following at a shell prompt:  
su - 

2.2.1. Configuring the Date and Time 

The date command allows the superuser to set the system date and time manually:  

1. To change the current date, type the command in the following form at a shell 
prompt, replacing the YYYY with a four-digit year, MM with a two-digit month, and DD 
with a two-digit day of the month:  
date +%D -s YYYY-MM-DD 

For example, to set the date to 2 June 2010, type:  
~]# date +%D -s 2010-06-02 

2. To change the current date, use the following command, where HH stands for an 
hour, MM is a minute, and SS is a second, all typed in a two-digit form:  
date +%T -s HH:MM:SS 

If your system clock is set to use UTC (Coordinated Universal Time), add the 
following option:  
date +%T -s HH:MM:SS -u 

For instance, to set the system clock to 11:26 PM using the UTC, type:  
~]# date +%T -s 23:26:00 -u 

You can check your current settings by typing date without any additional argument, for 
example:  
~]$ date 
Wed Jun  2 11:58:48 CEST 2010 

2.2.2. Configuring the Network Time Protocol 

As opposed to the manual setup described above, you can also synchronize the system clock 
with a remote server over the Network Time Protocol (NTP). For the one-time 
synchronization only, use the ntpdate command:  

1. Check whether the selected NTP server is accessible by using the ntpdate command 
in the following form:  
ntpdate -q server_address 
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For example, to connect to 0.fedora.pool.ntp.org, type:  
~]# ntpdate -q 0.fedora.pool.ntp.org 
server 204.15.208.61, stratum 2, offset -39.275438, delay 0.16083 
server 69.65.40.29, stratum 2, offset -39.269122, delay 0.17191 
server 148.167.132.201, stratum 2, offset -39.270239, delay 0.20482 
23 May 01:05:54 ntpdate[10619]: step time server 204.15.208.61 offset -
39.275438 sec 

2. When you find a satisfactory server, run the ntpdate command followed with one or 
more server addresses:  
ntpdate server_address... 

For instance:  
~]# ntpdate 0.fedora.pool.ntp.org 1.fedora.pool.ntp.org 
23 May 01:07:13 ntpdate[10669]: step time server 204.15.208.61 offset -
39.275436 sec 

Unless an error message is displayed, the system time should now be set. You can 
check the current by setting typing date without any additional arguments as 
shown in Section 2.2.1, Configuring the Date and Time (page 41). 

3. In most cases, these steps are sufficient. Only if you really need one or more system 
services to always use the correct time, enable running the ntpdate at boot time:  
systemctl enable ntpdate.service 

For more information about system services and their setup, refer to Chapter 7, 
Services and Daemons (page 120). 

Note 

If the synchronization with the time server at boot time keeps failing, that is, you 
find a relevant error message in the /var/log/boot.log system log, try to add the 
following line to /etc/sysconfig/network: 
NETWORKWAIT=1 

However, the more convenient way is to set the ntpd daemon to synchronize the time at 
boot time automatically:  

1. Open the NTP configuration file /etc/ntp.conf in a text editor, creating a new one 
if it does not already exist.  

2. Add or edit the list of public NTP servers. If you are using Fedora 15, the file should 
already contain the following lines, but feel free to change or expand these according 
to your needs:  
server 0.fedora.pool.ntp.org iburst 
server 1.fedora.pool.ntp.org iburst 
server 2.fedora.pool.ntp.org iburst 
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 Speeding up initial synchronization 

To speed the initial synchronization up, it is recommended that the iburst directive 
is added at the end of each server line. 

3. In the same file, set the proper permissions, giving the unrestricted access to 
localhost only:  
restrict default kod nomodify notrap nopeer noquery 
restrict -6 default kod nomodify notrap nopeer noquery 
restrict 127.0.0.1 
restrict -6 ::1 

4. Save the changes, exit the editor, and restart the NTP daemon:  
systemctl restart ntpd.service 

5. Additionally, make sure that ntpd daemon is started at boot time:  
systemctl enable ntpd.service 

2.3. Additional Resources 

For more information about the date and time configuration, refer to the following 
resources.  

2.3.1. Additional Resources 

• date(1) — The manual page for the date utility.  
• ntpdate(8) — The manual page for the ntpdate utility.  
• ntpd(8) — The manual page for the ntpd service. 
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Chapter 3. 
Managing Users and Groups 

The control of users and groups is a core element of Fedora system administration. Users can 
be either people (meaning accounts tied to physical users) or accounts which exist for 
specific applications to use. Groups are logical expressions of organization, tying users 
together for a common purpose. Users within a group can read, write, or execute files 
owned by that group.  

Each user is associated with a unique numerical identification number called a userid (UID); 
likewise, each group is associated with a groupid (GID).  

A user who creates a file is also the owner and group owner of that file. The file is assigned 
separate read, write, and execute permissions for the owner, the group, and everyone else. 
The file owner can be changed only by the root user, and access permissions can be 
changed by both the root user and file owner.  

Fedora also supports access control lists (ACLs) for files and directories which allow 
permissions for specific users outside of the owner to be set. For more information about 
ACLs, refer to the Access Control Lists chapter of the Fedora Storage Administration Guide.  



Chapter 3. Managing Users and Groups 

   
45 

3.1. User Accounts Tool 

The User Accounts configuration tool allows you to view, modify, add, and delete local 
users. To run the utility, either select Applications → System Tools → System Settings 
from the Activities menu and click the User Accounts icon, or click your name on the panel 
and choose My Account from the drop-down menu.  

The main window of the User Accounts configuration tool is divided into two parts: The left 
side of the window contains a list of available user accounts. The right side provides details 
on a particular account.  

By default, the tool only allows you to change certain settings regarding your account. This 
is because only root is allowed to configure users and groups. To unlock the configuration 
tool for all kinds of changes, click the Unlock button in the bottom-left corner of the 
window, and provide the root password when prompted.  

 
Figure 3.1. The User Accounts configuration tool 
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3.1.1. Configuring an Account 

To change the image associated with an account, click the icon next to the account name and 
either select a picture from the drop-down list, or click Browse for more pictures... to use an 
image from your local drive.  

To change the name associated with an account, click the name next to the icon to edit it.  

To change the account type, use the Account type drop-down list. However, this change 
requires the configuration tool to be unlocked even if it is your account.  

To change the default language for an account, click the button next to the Language label, 
and select the desired language from the list.  

To change the password, click the button next to the Password label. A dialog box will ap-
pear, allowing you to set the new password. Note that the current password must be provi-
ded in order to confirm the change. Once done, click the Change button to save the change.  

 
Figure 3.2. Changing the password 

 Password security advice 

It is advisable to use a much longer password, as this makes it more difficult for an 
intruder to guess it and access the account without permission. It is also 
recommended that the password not be based on a dictionary term: use a 
combination of letters, numbers and special characters. 

Finally, to set up automatic login for a particular account, enable the Automatic Login 
switch. The configuration tool must be unlocked to make this change.  
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3.1.2. Adding a New User 

To add a new user, make sure the configuration tool is unlocked, and click the + button (that 
is, the plus sign) below the account list. A dialog box as shown in Figure 3.3. Creating a new 
account below will appear. 

 
Figure 3.3. Creating a new account 

Take the followign steps to create an account:  

1. Select an account type from the Account type drop-down list. Available account 
types are Administrator and Standard (the default option).  

2. Fill in the Full name input field to set the name associated with the account. This 
name will be used by the login manager, and will be displayed on the panel.  

3. Either select a suggested username from the Username drop-down list, or fill in the 
corresponding input field.  

4. Click the Create button to confirm the settings.  
Fedora uses a user private group (UPG) scheme. The UPG scheme does not add or change 
anything in the standard UNIX way of handling groups; it offers a new convention. 
Whenever you create a new user, a unique group with the same name as the user is created.  

When a new account is created, default configuration files are copied from the /etc/skel/ 
directory into the new home directory.  
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3.1.3. Removing a User 

To remove a user, make sure the configuration tool is unlocked, select the desired account 
from the account list, and click the − button (that is, the minus sign) below the account list. 
A dialog box as shown in Figure 3.4. Removing an account below will appear.  

 
Figure 3.4. Removing an account 

To delete files and directories that belong to the user (that is, the home directory, mail spool, 
and temporary files), click the Delete Files button. To keep these files intact and only delete 
the user account, click Keep Files. To abort the deletion, click Cancel. 
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3.2. User Manager Tool 

The User Manager allows you to view, modify, add, and delete local users and groups.  

 
Figure 3.5. The GNOME User Manager 

You can start the User Manager by clicking Applications → Other → Users and Groups 
from the Activities menu. Alternatively, you can enter system-config-users at the shell 
prompt to open the User Manager. Viewing and modifying user and group information 
requires superuser privileges. If you are not the superuser when you open the User 
Manager, it will prompt you for the superuser password.  
To view a list of local users on the system, click the Users tab. To view a list of local groups 
on the system, click the Groups tab.  
To find a specific user or group, type the first few letters of the name in the Search filter 
field. Press Enter or click the Apply filter button. The filtered list is displayed.  
To sort the users, click on the column User Name and for groups click on Group Name. The 
users or groups are sorted according to the value of that column.  
Fedora reserves user IDs below 500 for system users. By default, the User Manager does not 
display system users. To view all users, including the system users, go to Edit → 
Preferences and uncheck Hide system users and groups from the dialog box.  
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3.2.1. Adding a New User 

To add a new user, click the Add User button. A window as shown in Figure 3.6. Creating a 
new user below appears. Type the username and full name for the new user in the 
appropriate fields. Type the user's password in the Password and Confirm Password fields. 
The password must be at least six characters.  

Password security advice 

It is advisable to use a much longer password, as this makes it more difficult for an 
intruder to guess it and access the account without permission. It is also 
recommended that the password not be based on a dictionary term: use a 
combination of letters, numbers and special characters. 

Select a login shell from the pulldown list. If you are not sure which shell to select, accept 
the default value of /bin/bash. The default home directory is /home/username/. You can 
change the home directory that is created for the user, or you can choose not to create the 
home directory by unselecting Create home directory.  

If you select to create the home directory, default configuration files are copied from the 
/etc/skel/ directory into the new home directory.  

Fedora uses a user private group (UPG) scheme. The UPG scheme does not add or change 
anything in the standard UNIX way of handling groups; it offers a new convention. 
Whenever you create a new user, by default, a unique group with the same name as the user 
is created. If you do not want to create this group, unselect Create a private group for the 
user.  

To specify a user ID for the user, select Specify user ID manually. If the option is not 
selected, the next available user ID above 500 is assigned to the new user. Because Fedora 
reserves user IDs below 500 for system users, it is not advisable to manually assign user IDs 
1-499.  

Click OK to create the user.  
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Figure 3.6. Creating a new user 

To configure more advanced user properties, such as password expiration, modify the user's 
properties after adding the user.  
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Modifying User Properties 

To view the properties of an existing user, click on the Users tab, select the user from the 
user list, and click Properties from the menu (or choose File → Properties from the 
pulldown menu). A window similar to Figure 3.7. User Properties below appears.  

 
Figure 3.7. User Properties 

The User Properties window is divided into multiple tabbed pages:  

• User Data — Shows the basic user information configured when you added the user. 
Use this tab to change the user's full name, password, home directory, or login shell.  

• Account Info — Select Enable account expiration if you want the account to expire 
on a certain date. Enter the date in the provided fields. Select Local password is 
locked to lock the user account and prevent the user from logging into the system.  

• Password Info — Displays the date that the user's password last changed. To force 
the user to change passwords after a certain number of days, select Enable password 
expiration and enter a desired value in the Days before change required: field. The 
number of days before the user's password expires, the number of days before the 
user is warned to change passwords, and days before the account becomes inactive 
can also be changed.  

• Groups — Allows you to view and configure the Primary Group of the user, as well 
as other groups that you want the user to be a member of.  
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3.2.2. Adding a New Group 

To add a new user group, select Add Group from the toolbar. A window similar to Figure 
3.8. New Group below appears. Type the name of the new group. To specify a group ID for 
the new group, select Specify group ID manually and select the GID. Note that Fedora also 
reserves group IDs lower than 500 for system groups.  

 
Figure 3.8. New Group 

Click OK to create the group. The new group appears in the group list.  

3.2.3. Modifying Group Properties 

To view the properties of an existing group, select the group from the group list and click 
Properties from the menu (or choose File → Properties from the pulldown menu). A 
window similar to Figure 3.9. Group Properties below appears.  

 
Figure 3.9. Group Properties 
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The Group Users tab displays which users are members of the group. Use this tab to add or 
remove users from the group. Click OK to save your changes.  

3.3. User and Group Management Tools 

Managing users and groups can be tiresome; this is why Fedora provides tools and 
conventions to make this task easier to manage.  

The easiest way to manage users and groups is through the graphical application, User 
Manager (system-config-users). For more information on User Manager, refer to Section  
3.2, User Manager Tool (page 49). 

The following command line tools can also be used to manage users and groups:  

• useradd, usermod, and userdel — Industry-standard methods of adding, deleting 
and modifying user accounts  

• groupadd, groupmod, and groupdel — Industry-standard methods of adding, 
deleting, and modifying user groups  

• gpasswd — Industry-standard method of administering the /etc/group file  
• pwck, grpck — Tools used for the verification of the password, group, and 

associated shadow files  
• pwconv, pwunconv — Tools used for the conversion of passwords to shadow 

passwords and back to standard passwords  

3.3.1. Command Line Configuration 

If you prefer command line tools or do not have the X Window System installed, use 
following to configure users and groups.  

Adding a User 

To add a user to the system:  

1. Issue the useradd command to create a locked user account:  
useradd username 

2. Unlock the account by issuing the passwd command to assign a password and set 
password aging guidelines:  
passwd username 

Command line options for useradd are detailed in Table 3.1. useradd Command Line 
Options below. 
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Option  Description  
-c 'comment'  comment can be replaced with any string. This option is generally used to 

specify the full name of a user.  
-d home_directory  Home directory to be used instead of default /home/username/.  
-e date  Date for the account to be disabled in the format YYYY-MM-DD.  
-f days  Number of days after the password expires until the account is disabled. If 

0 is specified, the account is disabled immediately after the password 
expires. If -1 is specified, the account is not be disabled after the password 
expires.  

-g group_name  Group name or group number for the user's default group. The group must 
exist prior to being specified here.  

-G group_list  List of additional (other than default) group names or group numbers, 
separated by commas, of which the user is a member. The groups must 
exist prior to being specified here.  

-m  Create the home directory if it does not exist.  
-M  Do not create the home directory.  
-N  Do not create a user private group for the user.  
-p password  The password encrypted with crypt.  
-r  Create a system account with a UID less than 500 and without a home 

directory.  
-s  User's login shell, which defaults to /bin/bash.  
-u uid  User ID for the user, which must be unique and greater than 499.  

Table 3.1. useradd Command Line Options 

Adding a Group 

To add a group to the system, use the command groupadd:  
groupadd group_name 

Command line options for groupadd are detailed in Table 3.2. groupadd Command Line 
Options below. 

Option  Description  

-f, --force  When used with -g gid and gid already exists, groupadd will choose another 
unique gid for the group.  

-g gid  Group ID for the group, which must be unique and greater than 499.  

-K, --key key=value Override /etc/login.defs defaults.  
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Option  Description  

-o, --non-unique  Allow to create groups with duplicate.  

-p,  
--password password 

Use this encrypted password for the new group.  

-r  Create a system group with a GID less than 500.  

Table 3.2. groupadd Command Line Options 

Password Aging 

For security reasons, it is advisable to require users to change their passwords periodically. 
This can be done when adding or editing a user on the Password Info tab of the User 
Manager.  

To configure password expiration for a user from a shell prompt, use the chage command 
with an option from Table 3.3. chage Command Line Options below, followed by the 
username.  

Shadow passwords must be enabled to use chage 

Shadow passwords must be enabled to use the chage command. For more 
information, see Section 3.7, Shadow Passwords (page 66). 

Option  Description  

-d days  Specifies the number of days since January 1, 1970 the password was changed.  

-E date  Specifies the date on which the account is locked, in the format YYYY-MM-DD. 
Instead of the date, the number of days since January 1, 1970 can also be used.  

-I days  Specifies the number of inactive days after the password expiration before locking 
the account. If the value is 0, the account is not locked after the password expires.  

-l  Lists current account aging settings.  

-m days  Specify the minimum number of days after which the user must change passwords. 
If the value is 0, the password does not expire.  

-M days  Specify the maximum number of days for which the password is valid. When the 
number of days specified by this option plus the number of days specified with the 
-d option is less than the current day, the user must change passwords before using 
the account.  

-W days  Specifies the number of days before the password expiration date to warn the user.  

Table 3.3. chage Command Line Options 
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chage interactivity 

If the chage command is followed directly by a username (with no options), it 
displays the current password aging values and allows them to be changed 
interactively. 

You can configure a password to expire the first time a user logs in. This forces users to 
change passwords immediately.  

1. Set up an initial password — There are two common approaches to this step: the 
administrator can assign a default password, or he can use a null password.  
To assign a default password, type the following at a shell prompt:  
passwd username 

To assign a null password instead, use the following command:  
passwd -d username 

Avoid using null passwords whenever possible 

Using a null password, while convenient, is a highly insecure practice, as any third 
party can log in first and access the system using the insecure username. Always 
make sure that the user is ready to log in before unlocking an account with a null 
password. 

2. Force immediate password expiration — Type the following command:  
chage -d 0 username 

This command sets the value for the date the password was last changed to the 
epoch (January 1, 1970). This value forces immediate password expiration no matter 
what password aging policy, if any, is in place.  

Upon the initial log in, the user is now prompted for a new password.  

3.3.2. Explaining the Process 

The following steps illustrate what happens if the command useradd juan is issued on a 
system that has shadow passwords enabled:  

1. A new line for juan is created in /etc/passwd:  
juan:x:501:501::/home/juan:/bin/bash 

The line has the following characteristics:  
• It begins with the username juan.  
• There is an x for the password field indicating that the system is using 

shadow passwords.  
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• A UID greater than 499 is created. Under Fedora, UIDs and GIDs below 500 
are reserved for system use. These should not be assigned to users.  

• A GID greater than 499 is created.  
• The optional GECOS information is left blank.  
• The home directory for juan is set to /home/juan/.  
• The default shell is set to /bin/bash.  

2. A new line for juan is created in /etc/shadow:  
juan:!!:14798:0:99999:7::: 

The line has the following characteristics:  
• It begins with the username juan.  
• Two exclamation marks (!!) appear in the password field of the 

/etc/shadow file, which locks the account.  

Note 

If an encrypted password is passed using the -p flag, it is placed in the /etc/shadow 
file on the new line for the user. 

• The password is set to never expire.  
3. A new line for a group named juan is created in /etc/group:  

juan:x:501: 

A group with the same name as a user is called a user private group. For more 
information on user private groups, refer to Section 3.2.1, Adding a New User (page 
50). 
The line created in /etc/group has the following characteristics:  

• It begins with the group name juan.  
• An x appears in the password field indicating that the system is using 

shadow group passwords.  
• The GID matches the one listed for user juan in /etc/passwd.  

4. A new line for a group named juan is created in /etc/gshadow:  
juan:!:: 

The line has the following characteristics:  
• It begins with the group name juan.  
• An exclamation mark (!) appears in the password field of the /etc/gshadow 

file, which locks the group.  
• All other fields are blank.  
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5. A directory for user juan is created in the /home/ directory:  
~]# ls -l /home 
total 4 
drwx------. 4 juan juan 4096 Mar  3 18:23 juan 

This directory is owned by user juan and group juan. It has read, write, and execute 
privileges only for the user juan. All other permissions are denied.  

6. The files within the /etc/skel/ directory (which contain default user settings) are 
copied into the new /home/juan/ directory:  
~]# ls -la /home/juan 
total 28 
drwx------. 4 juan juan 4096 Mar  3 18:23 . 
drwxr-xr-x. 5 root root 4096 Mar  3 18:23 .. 
-rw-r--r--. 1 juan juan   18 Jun 22  2010 .bash_logout 
-rw-r--r--. 1 juan juan  176 Jun 22  2010 .bash_profile 
-rw-r--r--. 1 juan juan  124 Jun 22  2010 .bashrc 
drwxr-xr-x. 2 juan juan 4096 Jul 14  2010 .gnome2 
drwxr-xr-x. 4 juan juan 4096 Nov 23 15:09 .mozilla 

At this point, a locked account called juan exists on the system. To activate it, the 
administrator must next assign a password to the account using the passwd command and, 
optionally, set password aging guidelines.  

3.4. Standard Users 

Table 3.4. Standard Users below lists the standard users configured in the /etc/passwd file 
by an Everything installation. The group ID (GID) in this table is the primary group for the 
user. See Section 3.5, Standard Groups (page 63) for a listing of standard groups.  

User  UID  GID  Home Directory  Shell  Packages  
root  0  0  /root  /bin/bash  setup  
bin  1  1  /bin  /sbin/nologin  setup  
daemon  2  2  /sbin  /sbin/nologin  setup  
sys  —  3  —  —  setup  
adm  3  4  /var/adm  /bin/bash  setup  
tty  —  5  —  —  setup  
disk  —  6  —  —  setup  
lp  4  7  /var/spool/lpd  /sbin/nologin  setup  
mem  —  8  —  —  setup  
kmem  —  9  —  —  setup  
wheel  —  10  —  —  setup  
cdrom  —  11  —  —  udev, MAKEDEV  
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User  UID  GID  Home Directory  Shell  Packages  
sync  5  (0)  /sbin  /bin/sync  setup  
shutdown  6  (0)  /sbin  /sbin/shutdown  setup  
halt  7  (0)  /sbin  /sbin/halt  setup  
mail  8  12  /var/spool/mail  /sbin/nologin  setup  
news  9  13  /var/spool/news  /sbin/nologin  setup  
uucp  10  14  /var/spool/uucp  /sbin/nologin  setup  
operator  11  (0)  /root  /sbin/nologin  setup  
games  12  (100)  /usr/games  /sbin/nologin  setup  
gopher  13  30  /usr/lib/gopher-data /sbin/nologin  setup  
ftp  14  50  /var/ftp  /sbin/nologin  setup  
man  —  15  —  —  setup  
oprofile  16  16  /home/oprofile  /sbin/nologin  oprofile  
pkiuser  17  17  /usr/share/pki  /sbin/nologin  pki-ca, rhpki-ca  
dialout  —  18  —  —  udev, MAKEDEV  
floppy  —  19  —  —  dev, MAKEDEV  
games  —  20  —  —  setup  
slocate  —  21  —  —  slocate  
utmp  —  22  —  —  initscripts, 

libutempter  
squid  23  23  /var/spool/squid  /dev/null  squid  
pvm  24  24  /usr/share/pvm3  /bin/bash  pvm  
named  25  25  /var/named  /bin/false  bind  
postgres  26  26  /var/lib/pgsql  /bin/bash  postgresql-server  
mysql  27  27  /var/lib/mysql  /bin/bash  mysql  
nscd  28  28  /  /bin/false  nscd  
rpcuser  29  29  /var/lib/nfs  /bin/false  nfs-utils  
console  —  31  —  —  dev  
rpc  32  32  /  /bin/false  portmap  
amanda  33  (6)  /var/lib/amanda  /bin/false  amanda  
tape  —  33  —  —  udev, MAKEDEV  
netdump  34  34  /var/crash  /bin/bash  netdump-client, 

netdump-server  
utempter  —  35  —  —  libutempter  
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User  UID  GID  Home Directory  Shell  Packages  
vdsm  36  —  /  /bin/bash  kvm, vdsm  
kvm  —  36  —  —  kvm, vdsm, libvirt  
rpm  37  37  /var/lib/rpm  /bin/bash  rpm  
ntp  38  38  /etc/ntp  /sbin/nologin  ntp  
video  —  39  —  —  setup  
dip  —  40  —  —  setup  
mailman  41  41  /var/mailman  /bin/false  mailman  
gdm  42  42  /var/gdm  /bin/bash  gdm  
xfs  43  43  /etc/X11/fs  /bin/false  XFree86-xfs  
pppusers  —  44  —  —  linuxconf  
popusers  —  45  —  —  linuxconf  
slipusers  —  46  —  —  linuxconf  
mailnull  47  47  /var/spool/mqueue  /dev/null  sendmail  
apache  48  48  /var/www  /bin/false  apache  
wnn  49  49  /home/wnn  /bin/bash  FreeWnn  
smmsp  51  51  /var/spool/mqueue  /dev/null  sendmail  
puppet  52  52  /var/lib/puppet  /sbin/nologin  puppet  
tomcat  53  53  /var/lib/tomcat  /sbin/nologin  tomcat  
lock  —  54  —  —  lockdev  
ldap  55  55  /var/lib/ldap  /bin/false  openldap-servers  
frontpage  56  56  /var/www  /bin/false  mod_frontpage  
nut  57  57  /var/lib/ups  /bin/false  nut  
beagleindex 58  58  /var/cache/beagle  /bin/false  beagle  
tss  59  59  —  /sbin/nologin  trousers  
piranha  60  60  /etc/sysconfig/ha  /dev/null  piranha  
prelude-
manager  

61  61  —  /sbin/nologin  prelude-manager  

snortd  62  62  —  /sbin/nologin  snortd  
audio  —  63  —  —  setup  
condor  64  64  /var/lib/condor  /sbin/nologin  condord  
nslcd  65  (55)  /  /sbin/nologin  nslcd  
wine  —  66  —  —  wine  
pegasus  66  65  /var/lib/Pegasus  /sbin/nologin  tog-pegasus  



Part I. Basic System Configuration 

   
62 

User  UID  GID  Home Directory  Shell  Packages  
webalizer  67  67  /var/www/html/usage /sbin/nologin  webalizer  
haldaemon  68  68  /  /sbin/nologin  hal  
vcsa  69  69  —  /sbin/nologin  dev, MAKEDEV  
avahi  70  70  /var/run/avahi-daemon /sbin/nologin  avahi  
realtime  —  71  —  —  —  
tcpdump  72  72  /  /sbin/nologin  tcpdump  
privoxy  73  73  /etc/privoxy  /bin/bash  privoxy  
sshd  74  74  /var/empty/sshd  /sbin/nologin  openssh-server  
radvd  75  75  /  /bin/false  radvd  
cyrus  76  (12)  /var/imap  /bin/bash  cyrus-imapd  
saslauth  —  76  —  —  cyrus-imapd  
arpwatch  77  77  /var/lib/arpwatch  /sbin/nologin  arpwatch  
fax  78  78  /var/spool/fax  /sbin/nologin  mgetty  
nocpulse  79  79  /etc/sysconfig/nocpulse /bin/bash  nocpulse  
desktop  80  80  —  /sbin/nologin  desktop-file-utils  
dbus  81  81  /  /sbin/nologin  dbus  
jonas  82  82  /var/lib/jonas  /sbin/nologin  jonas  
clamav  83  83  /tmp  /sbin/nologin  clamav  
screen  —  84  —  —  screen  
quaggavt  —  85  —  —  quagga  
sabayon  86  86  —  /sbin/nologin  sabayon  
polkituser 87  87  /  /sbin/nologin  PolicyKit  
wbpriv  —  88  —  —  samba-common  
postfix  89  89  /var/spool/postfix /bin/true  postfix  
postdrop  —  90  —  —  postfix  
majordomo  91  91  /usr/lib/majordomo /bin/bash  majordomo  
quagga  92  92  /  /sbin/nologin  quagga  
exim  93  93  /var/spool/exim  /sbin/nologin  exim  
distcache  94  94  /  /sbin/nologin  distcache  
radiusd  95  95  /  /bin/false  freeradius  
hsqldb  96  96  /var/lib/hsqldb  /sbin/nologin  hsqldb  
dovecot  97  97  /usr/libexec/dovecot /sbin/nologin  dovecot  
ident  98  98  /  /sbin/nologin  ident  
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User  UID  GID  Home Directory  Shell  Packages  
nobody  99  99  /  /sbin/nologin  setup  
users  —  100  —  —  setup  
qemu  107  107  /  /sbin/nologin  libvirt  
ovirt  108  108  /  /sbin/nologin  libvirt  
saned  111  111  /  /sbin/nologin  sane-backends  
vhostmd  112  112  /usr/share/vhostmd /sbin/nologin  vhostmd  
usbmuxd  113  113  /  /sbin/nologin  usbmuxd  
bacula  133  133  /var/spool/bacula /sbin/nologin  bacula  
ricci  140  140  /var/lib/ricci  /sbin/nologin  ricci  
luci  141  141  /var/lib/luci  /sbin/nologin  luci  
stap-server 155  155  /var/lib/stap-server /sbin/nologin  systemtap  
avahi-autoipd 170  170  /var/lib/avahi-autoipd /sbin/nologin  avahi  
pulse  171  171  /var/run/pulse  /sbin/nologin  pulseaudio  
rtkit  172  172  /proc  /sbin/nologin  rtkit  
nfsnobody 655341 65534  /var/lib/nfs  /sbin/nologin  nfs-utils  

Table 3.4. Standard Users 

3.5. Standard Groups 

Table 3.5. Standard Groups below lists the standard groups configured by an Everything 
installation. Groups are stored in the /etc/group file.  

Group  GID  Members  

root  0  root  

bin  1  root, bin, daemon  

daemon  2  root, bin, daemon  

sys  3  root, bin, adm  

adm  4  root, adm, daemon  

tty  5  —  

disk  6  root  

lp  7  daemon, lp  

mem  8  —  

                                                      
1 nfsnobdy is 4294967294 on 64-bit platforms 



Part I. Basic System Configuration 

   
64 

Group  GID  Members  

kmem  9  —  

wheel  10  root  

mail  12  mail, postfix  

uucp  14  uucp  

man  15  —  

games  20  —  

gopher  30  —  

video  39  —  

dip  40  —  

ftp  50  —  

lock  54  —  

audio  63  —  

nobody  99  —  

users  100  —  

dbus  81  —  

usbmuxd  113  —  

utmp  22  —  

utempter  35  —  

avahi-autoipd  170  —  

floppy  19  —  

vcsa  69  —  

rpc  32  —  

rtkit  499  —  

abrt  498  —  

nscd  28  —  

desktop_admin_r  497  —  

desktop_user_r  496  —  

cdrom  11  —  

tape  33  —  

dialout  18  —  

haldaemon  68  haldaemon  

apache  48  —  

ldap  55  —  
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Group  GID  Members  

saslauth  495  —  

postdrop  90  —  

postfix  89  —  

avahi  70  —  

ntp  38  —  

rpcuser  29  —  

nfsnobody  65534  —  

pulse  494  —  

pulse-access  493  —  

fuse  492  —  

gdm  42  —  

stapdev  491  —  

stapusr  490  —  

sshd  74  —  

tcpdump  72  —  

slocate  21  —  

dovecot  97  —  

dovenull  489  —  

mailnull  47  —  

smmsp  51  —  

Table 3.5. Standard Groups 

3.6. User Private Groups 
Fedora uses a user private group (UPG) scheme, which makes UNIX groups easier to manage. 
A UPG is created whenever a new user is added to the system. It has the same name as the 
user for which it was created and that user is the only member of the UPG.  
UPGs make it safe to set default permissions for a newly created file or directory, allowing 
both the user and the group of that user to make modifications to the file or directory.  
The setting which determines what permissions are applied to a newly created file or 
directory is called a umask and is configured in the /etc/bashrc file. Traditionally on UNIX 
systems, the umask is set to 022, which allows only the user who created the file or directory 
to make modifications. Under this scheme, all other users, including members of the creator's 
group, are not allowed to make any modifications. However, under the UPG scheme, this 
"group protection" is not necessary since every user has their own private group.  
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3.6.1. Group Directories 

System administrators usually like to create a group for each major project and assign 
people to the group when they need to access that project's files. With this traditional 
scheme, file managing is difficult; when someone creates a file, it is associated with the 
primary group to which they belong. When a single person works on multiple projects, it 
becomes difficult to associate the right files with the right group. However, with the UPG 
scheme, groups are automatically assigned to files created within a directory with the setgid 
bit set. The setgid bit makes managing group projects that share a common directory very 
simple because any files a user creates within the directory are owned by the group which 
owns the directory.  

For example, a group of people need to work on files in the /opt/myproject/ directory. 
Some people are trusted to modify the contents of this directory, but not everyone.  

1. As root, create the /opt/myproject/ directory by typing the following at a shell 
prompt:  
mkdir /opt/myproject 

2. Add the myproject group to the system:  
groupadd myproject 

3. Associate the contents of the /opt/myproject/ directory with the myproject group:  
chown root:myproject /opt/myproject 

4. Allow users to create files within the directory, and set the setgid bit:  
chmod 2775 /opt/myproject 

At this point, all members of the myproject group can create and edit files in the 
/opt/myproject/ directory without the administrator having to change file permissions 
every time users write new files. To verify that the permissions have been set correctly, run 
the following command:  
~]# ls -l /opt 
total 4 
drwxrwsr-x. 3 root myproject 4096 Mar  3 18:31 myproject 

3.7. Shadow Passwords 

In multiuser environments it is very important to use shadow passwords (provided by the 
shadow-utils package). Doing so enhances the security of system authentication files. For 
this reason, the installation program enables shadow passwords by default.  

The following list shows the advantages shadow passwords have over the traditional way 
of storing passwords on UNIX-based systems:  
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• Improves system security by moving encrypted password hashes from the world-
readable /etc/passwd file to /etc/shadow, which is readable only by the root user.  

• Stores information about password aging.  
• Allows the /etc/login.defs file to enforce security policies.  

Most utilities provided by the shadow-utils package work properly whether or not 
shadow passwords are enabled. However, since password aging information is stored 
exclusively in the /etc/shadow file, any commands which create or modify password aging 
information do not work.  
The following is a list of commands which do not work without first enabling shadow 
passwords:  

• chage  
• gpasswd  
• usermod -e or -f options  
• useradd -e or -f options  

3.8. Additional Resources 

For more information about users and groups, and tools to manage them, refer to the 
following resources.  

3.8.1. Installed Documentation 

• Related man pages — There are a number of man pages for the various applications 
and configuration files involved with managing users and groups. Some of the more 
important man pages have been listed here:  
User and Group Administrative Applications 

• man chage — A command to modify password aging policies and account 
expiration.  

• man gpasswd — A command to administer the /etc/group file.  
• man groupadd — A command to add groups.  
• man grpck — A command to verify the /etc/group file.  
• man groupdel — A command to remove groups.  
• man groupmod — A command to modify group membership.  
• man pwck — A command to verify the /etc/passwd and /etc/shadow files.  
• man pwconv — A tool to convert standard passwords to shadow passwords.  
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• man useradd — A command to add users.  
• man userdel — A command to remove users.  
• man usermod — A command to modify users.  

Configuration Files 
• man 5 group — The file containing group information for the system.  
• man 5 passwd — The file containing user information for the system.  
• man 5 shadow — The file containing passwords and account expiration 

information for the system. 
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